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Chapter 202

Conditional Power and
Sample Size
Reestimation of Tests
for the Difference
Between Two
Proportions
Introduction
In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the
experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to
evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional
power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to
the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power
over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment
techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow
and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).
This program module computes conditional and predicted power for the case when a z-test is used to test whether the
event probabilities of two populations are different. It also provides sample size reestimation to achieve a specified
conditional power value.

Technical Details
All details and assumptions usually made when using a two-sample z-test to test the difference between two
proportions continue to be in force here.
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Conditional Power
The power of an experiment indicates whether a study is likely to result in useful results, given the sample size.
Low power means that the study is futile: little chance of statistical significance even though the alternative
hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the
study has started. When this happens, the study is curtailed.
The futility of a study that is underway can be determined by calculating its conditional power: the probability of
statistical significance at the completion of the study given the data obtained so far.
It is important to note that conditional power at the beginning of the study before any data are collected is equal to
the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional
power will seldom result in study curtailment very early in the study.
From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage k for
rejecting a null hypothesis about a parameter θ at the end of the study, given the observed test statistic, Z k , is
computed as

 Z I − z1−α I K + θ (I K − I k ) 
,
Puk (θ ) = Φ  k k
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the general lower one-sided conditional power at stage k is computed as

 − Z k I k − z1−α I K − θ (I K − I k ) 
,
Plk (θ ) = Φ 


I
I
−
K
k


and the general two-sided conditional power at stage k is computed as

 Z I − z1−α / 2 I K + θ (I K − I k ) 
 − Z k I k − z1−α / 2 I K − θ (I K − I k ) 
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where

θ = the parameter being tested by the hypothesis
k = an interim stage at which the conditional power is computed (k = 1,…, K – 1)
K = the stage at which the study is terminated and the final test computed

Z k = the test statistic calculated from the observed data that has been collected up to stage k
I k = the information level at stage k
I K = the information level at the end of the study

z1−α = the standard normal value for the test with a type I error rate of α.
For a test of a two proportions with null hypothesis H0: P1 = P2 , where P1 and P2 are the population proportions
in groups 1 and 2, respectively, under the alternative hypothesis, these components are computed in Chang (2008)
pages 70 and 71 as

θ = P2 − P1 (the expected difference under the alternative hypothesis)
Z k = ( p2 k − p1k ) Iˆk

(the z-statistic computed from the observed data)
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−1

(the interim information level)

−1

(the final information level)

where

p jk is the sample proportion for group j, estimating Pj at stage k
Iˆk is the estimated information from the sample at stage k

n jk is the sample size in group j at stage k
n j is the final sample size in group j

σ 2 = p (1 − p ) with p = (P1 + P2 ) / 2
Computing conditional power requires you to set P1 and P2 . Their values can come from the values used during
the planning of the study, from similar studies, or from estimates made from the data that has emerged.

Futility Index
The futility index is 1 − 𝑃𝑃𝑘𝑘 (𝜃𝜃)|𝐻𝐻1. The study may be stopped if this index is above 0.8 or 0.9 (that is, if
conditional power falls below 0.2 or 0.1).

Predictive Power
Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution
of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power
at stage k is given by

 Z I − z1−α I k 
.
Puk = Φ  k K
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the general lower one-sided predictive power at stage k is given by

 − Z k I K − z1−α I k 
,
Plk = Φ 


I
−
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the general two-sided predictive power at stage k is given by

Z
Pk = Φ  k



 − Zk
I K − z1−α / 2 I k 
 + Φ


IK − Ik



I K − z1−α / 2 I k 
,

IK − Ik


with all terms defined as in the equations for conditional power.
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Sample Size Reestimation
As Chang (2014) points out, after an interim analysis, it is often desirable to recalculate the target sample size using
updated values for various nuisance parameters such as the variance. This process is known as sample size
reestimation.
One method of calculating an adjusted sample size estimate is to search for the sample size that results in a
predetermined value of conditional power. PASS conducts a binary search using the conditional power as the
criterion. The result is called the target sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Conditional Power or Sample Size Reestimation.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate conditional power directly. To find appropriate values of sample size, a binary
search is made using an iterative procedure until an appropriate value is found.

Test
Alternative Hypothesis
Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite, specifying the alternative is
all that is needed.
When you choose a one-sided option, you must be sure that the values of P1, P2, and δ1 are consistent with that
choice.

Conditional Power and Alpha
Conditional Power
Enter one or more values for the conditional power that is to be attained by the sample size search.
Conditional power is the probability of rejecting a false null hypothesis given the data that has been obtained so
far. It is a function of the effect size and the data that have been collected.
The valid range is between 0 to 1. Typically, values over 0.70 are considered high enough to continue a study,
while values below 0.10 considered grounds for curtailing the study.
You can enter a single value such as 0.80 or a series of values such as 0.80 0.85 0.90 0.95 or 0.7 to 0.97 by 0.05.
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Alpha
This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error
occurs when a true null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025
for one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N1 (Group 1 Target Sample Size)
Enter one or more values of the target sample size of group 1, the total number of subjects planned for this group.
This value must be an integer greater than one. Note that you may enter a list of values using the syntax
50,100,150,200,250 or 50 to 250 by 50.
N2 (Group 2 Target Sample Size)
Enter a value (or range of values) for the target sample size of group 2 or enter Use R to calculate N2 from N1.
You may enter a range of values such as 10 to 100 by 10.
•

Use R
If Use R is entered here, N2 is calculated using the formula
N2 = [R(N1)]
where R is the Sample Allocation Ratio and the operator [Y] is the first integer greater than or equal to Y. For
example, if you want N1 = N2, select Use R and set R = 1.

R (Sample Allocation Ratio)
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only used when N2 is
set to Use R.
When used, N2 is calculated from N1 using the formula: N2 = [R(N1)] where [Y] is the next integer greater than
or equal to Y. Note that setting R = 1.0 forces N2 = N1.
n1k (Group 1 Sample Size at k)
Enter the group 1 sample size obtained through look k. If this value is greater than N1, the value of N1 is
increased to this amount.
n2k (Group 2 Sample Size at k)
Enter the group 2 sample size obtained through look k. If this value is greater than N2, the value of N2 is
increased to this amount.
n1k
If n1k is entered here, n2k is set equal to n1k.
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Effect Size
Input Type
Indicate what type of values to enter to specify the difference. Regardless of the entry type chosen, the
calculations are the same. This option is simply given for convenience in specifying the difference.
The choices are
•

Proportions
Enter P1 (Group 1 Proportion) and P2 (Group 2 Proportion). The difference, δ1, is calculated as δ1 = P2 - P1.

•

Differences
Enter P1 (Group 1 Proportion) and δ1 (Actual Difference to Detect).

Effect Size – Proportions
P1 (Group 1 Proportion)
Enter one or more values for the probability of obtaining a success in group 1. This is the proportion of the group
1 population with the trait of interest.
You may enter a range of values such as 0.4 0.5 0.6 or 0.4 to 0.7 by 0.1. Since this is a proportion, all values must
be between 0 and 1.
P2 (Group 2 Proportion)
Enter one or more values for the probability of obtaining a success in group 2 assuming the alternative hypothesis.
This is the proportion of the group 2 population with the trait of interest.
You may enter a range of values such as 0.4 0.5 0.6 or 0.4 to 0.7 by 0.1. Since this is a proportion, all values must
be between 0 and 1.

Effect Size – Difference
δ1 (Actual Difference to Detect)
This is the actual difference between the two proportions at which conditional power is calculated. The difference
is equal to
δ1 = P2 - P1,
such that
P2 = P1 + δ1.
Care should be taken that this value is consistent with the alternative hypothesis. You can enter a single value or
multiple values in the range -1 < δ1 < 1.

Effect Size – Current Test Statistic
Zk (Current Test Statistic)
Enter the value of the z-statistic calculated from the data obtained through stage k. This value may be positive or
negative. Typically, the z-statistic ranges between -5 and 5.
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Example 1 – Computing Conditional Power
Suppose a study has been planned to detect a change in proportions of 10 percentage points from P1 = 0.6 to P2 =
0.7 at an alpha of 0.025 using a one-sided z-test. The target sample size is 60 per group. An interim analysis is
planned after half the data have been collected. The data monitoring board would like to have the conditional
power calculated for z values of 0, 0.5, 1, 1.5, 2, and 2.5.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 1
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................. Conditional Power
Alternative Hypothesis ......................................... H1: P2 - P1 > 0 (One-Sided)
Alpha .................................................................... 0.025
N1 (Group 1 Target Sample Size) ....................... 60
N2 (Group 2 Target Sample Size) ....................... Use R
R (Sample Allocation Ratio) ................................ 1.0
n1k (Group 1 Sample Size at Look k).................. 30
n2k (Group 2 Sample Size at Look k).................. n1k
Input Type ............................................................ Proportions
P1 (Group 1 Proportion) ...................................... 0.6
P2 (Group 2 Proportion) ...................................... 0.7
Zk (Current Test Statistic) .................................... 0 0.5 1 1.5 2 2.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample Z-Test ────────────────────────────────────────────
Hypotheses: H0: P2 - P1 ≤ 0 vs. H1: P2 - P1 > 0

Cond.
Power
0.02501
0.07217
0.16858
0.32283
0.51603
0.70547

Pred.
Power
0.02500
0.10513
0.29262
0.56409
0.80743
0.94244

Target
Sample
Size
N1|N2
60|60
60|60
60|60
60|60
60|60
60|60

Current
Sample
Size
n1k|n2k
30|30
30|30
30|30
30|30
30|30
30|30

Proportions
P1|P2
0.60|0.70
0.60|0.70
0.60|0.70
0.60|0.70
0.60|0.70
0.60|0.70

Proportion
Diff
P2 - P1
δ1
0.10
0.10
0.10
0.10
0.10
0.10

Test
Statistic
Zk
0.000
0.500
1.000
1.500
2.000
2.500

Alpha
0.025
0.025
0.025
0.025
0.025
0.025

Futility
0.97499
0.92783
0.83142
0.67717
0.48397
0.29453

References
Jennison, C., and Turnbull, B.W. 2000. Group Sequential Methods with Applications to Clinical Trials. Chapman
& Hall/CRC. New York.
Proschan, M., Lan, K.K.G., Wittes, J.T. 2006. Statistical Monitoring of Clinical Trials. Springer. New York.
Chang, Mark. 2008. Classical and Adaptive Clinical Trial Designs. John Wiley & Sons. Hoboken, New Jersey.
Chang, Mark. 2014. Adaptive Design Theory and Implementation Using SAS and R. CRC Press. New York.
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Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the
data that have emerged so far.
Predictive Power is the result of averaging the conditional power over the posterior distribution of the
effect size.
N1|N2 are the target sample sizes of groups 1 and 2, respectively.
n1k|n2k are the sample sizes of groups 1 and 2, respectively, obtained through stage k.
P1|P2 are the response proportions for groups 1 and 2, respectively.
δ1 = P2 - P1 is the actual difference to detect under the alternative hypothesis at which conditional power is
calculated.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be
stopped because there is little chance of achieving statistical significance.
Summary Statements
The first 30 of 60 subjects in group 1 and 30 of 60 subjects in group 2 achieve 2.501%
conditional power to detect a difference of δ1 = P2 - P1 = 0.70 - 0.60 = 0.10 using a one-sided
Z-test with a significance level of alpha = 0.025. The value of the test statistic from data
that have emerged so far is Zk = 0.000. The futility index is 0.97499.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are
given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and Zk.
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Example 2 – Validation
We could not find an example of a conditional power calculation for a two-sample proportions test in the
literature. Since the calculations are relatively simple, we will validate the calculation of the third scenario (Zk =
1) of Example 1 by hand.
In this case

Ik =

1

σ

2

(1 / n1k + 1 / n2 k )−1

1
1
 1
 + 
0.65(0.35)  30 30 
= 65.93406593

IK =
−1

1

σ

2

(1 / n1 + 1 / n2 )−1

1
1 
 1
 + 
0.65(0.35)  60 60 
= 131.86813187

=

−1

=

 Z I − z1−α I K + θ (I K − I k ) 

Puk (θ ) = Φ  k k


IK − Ik


 1.0 65.93406593 − (1.9599640) 131.86813187 + (0.7 − 0.6)(131.86813187 − 65.93406593) 

= Φ 

−
131
.
86813187
65
.
93406593


 - 7.79363524 
= Φ

 8.11997943 
= Φ (- 0.95980972 )
= 0.16857549

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 2
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................. Conditional Power
Alternative Hypothesis ......................................... H1: P2 - P1 > 0 (One-Sided)
Alpha .................................................................... 0.025
N1 (Group 1 Target Sample Size) ....................... 60
N2 (Group 2 Target Sample Size) ....................... Use R
R (Sample Allocation Ratio) ................................ 1.0
n1k (Group 1 Sample Size at Look k).................. 30
n2k (Group 2 Sample Size at Look k).................. n1k
Input Type ............................................................ Proportions
P1 (Group 1 Proportion) ...................................... 0.6
P2 (Group 2 Proportion) ...................................... 0.7
Zk (Current Test Statistic) .................................... 1
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample Z-Test ────────────────────────────────────────────
Hypotheses: H0: P2 - P1 ≤ 0 vs. H1: P2 - P1 > 0

Cond.
Power
0.16858

Pred.
Power
0.29262

Target
Sample
Size
N1|N2
60|60

Current
Sample
Size
n1k|n2k
30|30

Proportion
Diff
Proportions
P2 - P1
P1|P2
δ1
0.60|0.70
0.10

Test
Statistic
Zk
1.000

Alpha
0.025

Futility
0.83142

The conditional power of 0.16858 matches the value calculated by hand.
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Example 3 – Sample Size Reestimation
Suppose a study has been planned to detect a change in proportions of 10 percentage points from P1 = 0.6 to P2 =
0.7 at an alpha of 0.025 using a one-sided z-test. The target sample size was 60 per group. An interim analysis was
conducted after half the data had been collected. This analysis yielded a z-test value of 2.12. The value of P1 (the
proportion for the reference group) was found to be 0.643.
The data monitoring board would like to recalculate the sample size for a value of P2 of 0.743 (which keeps the
difference at 0.1) and a conditional power of 0.8.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 3
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................. Sample Size Reestimation
Alternative Hypothesis ......................................... H1: P2 - P1 > 0 (One-Sided)
Conditional Power................................................ 0.8
Alpha .................................................................... 0.025
N2 (Group 2 Target Sample Size) ....................... Use R
R (Sample Allocation Ratio) ................................ 1.0
n1k (Group 1 Sample Size at Look k).................. 30
n2k (Group 2 Sample Size at Look k).................. n1k
Input Type ............................................................ Proportions
P1 (Group 1 Proportion) ...................................... 0.643
P2 (Group 2 Proportion) ...................................... 0.743
Zk (Current Test Statistic) .................................... 2.12

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample Z-Test ────────────────────────────────────────────
Hypotheses: H0: P2 - P1 ≤ 0 vs. H1: P2 - P1 > 0

Cond.
Power
0.80022

Pred.
Power
0.93335

Target
Sample
Size
N1|N2
219|219

Current
Sample
Size
n1k|n2k
30|30

Proportion
Diff
Proportions
P2 - P1
P1|P2
δ1
0.64|0.74
0.10

Test
Statistic
Zk
2.120

Alpha
0.025

Futility
0.19978

Notice that the target sample size has increased from 60 per group (N = 120), to 219 per group (N = 438).
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